
ABSTRACT 

BEESON, ANNA LYNN SMITH. Estrous Cycle Impacts on Dendritic Spine Plasticity in Rat 

Nucleus Accumbens Core, Shell, and Caudate-Putamen. (Under the direction of Dr. John 

Meitzen). 

 

 

An important natural factor that can modulate neuron properties are sex-specific hormone 

fluctuations, including the human menstrual cycle and rat estrous cycle in adult females. 

Considering the striatal brain regions, the nucleus accumbens (NAc) core, NAc shell, and 

caudate-putamen (CPu), the estrous cycle has previously been shown to impact relevant 

behaviors and disorders, neuromodulator action, and medium spiny neuron (MSN) 

electrophysiology. Whether the estrous cycle impacts MSN dendritic spine attributes has not yet 

been examined, even though MSN spines and glutamatergic synapse properties are sensitive to 

exogenously applied estradiol. Thus, we hypothesized that MSN dendritic spine attributes would 

differ by estrous cycle phase. To test this hypothesis, brains from adult male rats and female rats 

in diestrus, proestrus AM, proestrus PM, and estrus phases were processed for Rapid Golgi-Cox 

staining. MSN dendritic spine density, size and type were analyzed in the NAc core, shell and 

CPu. Overall spine size differed across estrous cycle phases in female NAc core and NAc shell, 

and spine length differed across estrous cycle phase in NAc shell and CPu. Consistent with 

previous work, dendritic spine density was increased in the NAc core compared to the NAc shell 

and CPu, independent of sex and estrous cycle. Spine attributes in all striatal regions did not 

differ by sex when estrous cycle was disregarded. These results indicate, for the first time, that 

estrous cycle phase impacts dendritic spine plasticity in striatal regions, providing a 

neuroanatomical avenue by which sex-specific hormone fluctuations can impact striatal function 

and disorders.  
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CHAPTER 1 

Estrous cycle impacts on dendritic spine plasticity in rat nucleus accumbens core, shell, and 

caudate-putamen 

 

Research in this chapter will be submitted to a peer-reviewed journal: 

Beeson, A.L.S., Meitzen, J. (2022). Estrous cycle impacts on dendritic spine plasticity in rat 

nucleus accumbens core, shell, and caudate-putamen. In progress.  
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Abstract 

An important natural factor that can modulate neuron properties are sex-specific hormone 

fluctuations, including the human menstrual cycle and rat estrous cycle in adult females. 

Considering the striatal brain regions, the nucleus accumbens (NAc) core, NAc shell, and 

caudate-putamen (CPu), the estrous cycle has previously been shown to impact relevant 

behaviors and disorders, neuromodulator action, and medium spiny neuron (MSN) 

electrophysiology. Whether the estrous cycle impacts MSN dendritic spine attributes has not yet 

been examined, even though MSN spines and glutamatergic synapse properties are sensitive to 

exogenously applied estradiol. Thus, we hypothesized that MSN dendritic spine attributes would 

differ by estrous cycle phase. To test this hypothesis, brains from adult male rats and female rats 

in diestrus, proestrus AM, proestrus PM, and estrus phases were processed for Rapid Golgi-Cox 

staining. MSN dendritic spine density, size and type were analyzed in the NAc core, shell and 

CPu. Overall spine size differed across estrous cycle phases in female NAc core and NAc shell, 

and spine length differed across estrous cycle phase in NAc shell and CPu. Consistent with 

previous work, dendritic spine density was increased in the NAc core compared to the NAc shell 

and CPu, independent of sex and estrous cycle. Spine attributes in all striatal regions did not 

differ by sex when estrous cycle was disregarded. These results indicate, for the first time, that 

estrous cycle phase impacts dendritic spine plasticity in striatal regions, providing a 

neuroanatomical avenue by which sex-specific hormone fluctuations can impact striatal function 

and disorders. 
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Introduction 

Sex-specific hormone cycles naturally occur in reproductively mature mammals, 

including the focus of this manuscript, the female rat estrous cycle.  During the rat estrous cycle, 

dynamic changes in hormones including 17β-estradiol (estradiol) and progesterone occur within 

distinct phases over four to five days. These phases include the diestrus phase (sometimes further 

divided into metestrus and diestrus), proestrus AM phase, proestrus PM phase, and estrus phase 

(Adams et al. 2018; Ajayi and Akhigbe 2020). In the one-to-two-day diestrus phase, circulating 

concentrations of estradiol and progesterone are relatively low. These circulating hormone 

concentrations begin changing quickly during the proestrus AM phase, where estradiol surges in 

hours. Later that day, during the proestrus PM phase progesterone and estradiol concentrations 

fall. Following this rapid hormone fluctuation is the one-day estrus phase in which estradiol and 

progesterone are low, though the effects of these hormones may persist (Ajayi and Akhigbe 

2020; Hashimoto et al. 1987). While the structure and function of organs such as the ovary, 

hypothalamus, and pituitary famously change between each cycle phase, other brain regions and 

their constituent cells are also potentially highly sensitive to this cycle. Only a few select brain 

regions and cell types have been assessed for sensitivity to the estrous cycle. Regarding neural 

anatomical structure such as dendritic spines, mammalian brain regions such as the 

hippocampus, prefrontal cortex, and ventromedial nucleus of the hypothalamus, all show 

differences across estrous cycle phases (Chen et al. 2009; González-Burgos et al. 2015; Rasia-

Filho et al. 2004; Woolley and McEwen 1993). Changes in dendritic spines are particularly 

salient given that this structure plays important roles in synaptic connectivity and plasticity. 

Indeed, structures such as the rat hippocampus exhibit concomitant changes in neuronal synaptic 

electrophysiology between estrous cycle phases (Woolley et al. 1997). 
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These changes in synaptic electrophysiology are not limited to the hippocampus. Rat 

striatal brain regions also exhibit changes in synaptic and other types of physiology associated 

with the estrous cycle. These regions include the nucleus accumbens (NAc) core, NAc shell, and 

the caudate-putamen (CPu), which mediate important processes including motor control, habit 

formation, and reward and motivated behaviors, among many other functions (Floresco 2015; 

Graybiel and Grafton 2015).  For instance, in the NAc core, the frequency and amplitude of 

miniature excitatory post-synaptic currents (mEPSCs) changes across the estrous cycle in the 

most common striatal neuron type, the medium spiny neuron (MSN)(also called spiny projection 

neurons)(Proaño et al. 2018, 2020). MSNs represent the output neurons of all striatal regions and 

exhibit dendritic spines. mEPSCs are a direct functional assessment of AMPA receptor-mediated 

synapses and can correlate with dendritic spine attributes (Proaño et al. 2018; Schwarz et al. 

2008; Wissman et al. 2011). Specifically, mEPSC frequency is intermediate during diestrus, 

elevated during proestrus AM, crashes during proestrus PM, and elevated during estrus. mEPSC 

amplitude is intermediate during the diestrus and proestrus AM phases, elevated during proestrus 

PM, and returns to intermediate levels during estrus. Both mEPSC frequency and amplitude 

correlate with circulating estradiol and progesterone concentrations, and are rapidly sensitive to 

acute exogenous estradiol exposure (Krentzel et al. 2019; Proaño et al. 2018, 2020). MSN 

dendritic spine attributes and other glutamatergic synapse-associated markers have been shown 

to differ by sex and exhibit plasticity in response to exogenous estradiol exposures. For example, 

MSN dendritic spine density in the gonadectomized female hamster and rat decreases in 

response to exogenous estradiol exposure in the NAc core, and to a lesser extent, the NAc shell 

(Peterson et al. 2015a; Staffend et al. 2011). Exogenous estradiol acts to decrease spine density 

in the NAc core via a mGluR5 and endocannabinoid-mediated pathway (Gross et al. 2016; 
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Peterson et al. 2015a). An investigation of spine dynamics in the naturally cycling animal has yet 

to be undertaken. This is a critical knowledge gap given the importance of dendritic spines for 

neuronal computation, the changes in MSN electrophysiological function across the estrous 

cycle, and the known role of the striatal regions in mediating behaviors sensitive to estrous cycle 

phase.  

Here we test the overall hypothesis that MSN dendritic spine attributes differ by estrous 

cycle phase. Brains from adult male rats and female rats in diestrus, proestrus AM, proestrus PM, 

and estrus phases were processed for Rapid Golgi-Cox staining to visualize MSN dendritic 

spines. MSN dendritic spine density, size and type was evaluated in the NAc core, NAc shell, 

and CPu. We first present a test of the hypothesis that dendritic spine density differs between 

striatal regions independent of sex or the estrous cycle to replicate previous findings and validate 

our approach. We then disaggregate the spine data by sex to test the hypothesis that dendritic 

spine attributes differ by sex independent of estrous cycle phase. Next, we test the hypothesis 

that spine attributes differ by estrous cycle phase within each striatal region. Finally, we examine 

the distribution of spine types in males and females in each estrous cycle phase for each striatal 

region. 

Methods 

Animals 

All animal protocols were approved by the Institutional Animal Care and Use 

Committees at North Carolina State University and Charles River Laboratories. Postnatal day 50 

(P50) male and female Sprague-Dawley CD IGS rats were purchased from Charles River 

Laboratories (males: n=11; females: n=33). All animals were housed in a temperature- and light-

controlled room (23°C, 40% humidity, 12:12-h light-dark cycle with lights turned on and off at 7 
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AM and 7 PM, respectively) at the Biological Resource Facility of North Carolina State 

University. All cages were polysulfone Bisphenol A (BPA) free and were filled with bedding 

manufactured from virgin hardwood chips (Beta Chip; NEPCO, Warrensburg, NY) to avoid 

endocrine disruptors present in corncob bedding (Woolley and McEwen 1993). Soy protein-free 

rodent chow (2020X; Teklad, Madison, WI) and glass bottle-provided water were available ad 

libitum.  Females were distributed across the following phases of the estrous cycle: diestrus 

(n=8), proestrus AM (n=9), proestrus PM (n=8), and estrus (n=8). Age (days) at sacrifice was as 

follows, presented as mean  SE: proestrus AM (77.4  5.1), proestrus PM (70.7  4.6), estrus 

(75.9  5.1), diestrus (65.5  1), and male (73.0  3.9). Estrous cycle assessment was performed 

with a wet mount preparation as previously described (Hubscher et al. 2005; Proaño et al. 2018). 

Briefly, females were vaginally swabbed with potassium phosphate buffer solution at ~9:00 AM 

for diestrus, proestrus-AM, or estrus group females and ~5:15 PM for proestrus-PM group 

females. Slides were visualized under a microscope to determine estrous cycle phase according 

to cell morphology as previously described (Proaño et al. 2020; Westwood 2008). 

Golgi Impregnation and Slide Preparation 

Animals were euthanized using deep anesthesia with isoflurane followed by decapitation 

(~9:30 AM or ~6:00 PM) and their brains rapidly removed. Golgi-Cox staining was performed 

on whole brains using the FD Rapid GolgiStain™ Kit (FD NeuroTechnologies, Columbia, MD). 

Whole brains were submerged for 1 hour in ice-cold oxygenated artificial cerebrospinal fluid 

containing (in mM): 126 NaCl, 26 NaHCO3, 1 MgCl2, 1.25 NaH2PO4, 10 dextrose, and 2 

CaCl2, 3 KCl from Fisher Scientific, Pittsburg, PA; osmolarity 295–305 mOsm, pH 7.2–7.4. 

Whole brains were then placed in a 1:1 mixture of FD Solution A:B, prepared at least 24 hours in 

advance, for 2 weeks at room temperature in the dark. Select brains remained in Solution A:B for 
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11 weeks due to COVID-19 related mandated shutdowns (n=10). The Golgi impregnation 

process that occurred while in Solution A:B did not appear adversely affected by the longer 

incubation time, though the tissue was more fragile during sectioning, consistent with previous 

observations (Rosoklija et al. 2014). Brains were then moved to FD Solution C for 72 hours at 

room temperature in the dark. Both Solution A:B and Solution C were replaced after the first 24 

hours. Brains were then immersed in 30% (w/v) sucrose in diH2O for 1 to 10 days (n=36), or 11 

weeks due to COVID-19 related mandated shutdowns (n=8), for cryoprotection and storage prior 

to sectioning. No qualitative differences between tissue stored in the sucrose mixture for 1 to 10 

days or 7 weeks were observed. Tissue embedding medium (OCT Compound; Fisher 

HealthCare, Houston, TX) cooled by dry ice was used for affixing Golgi impregnated whole 

brains to the stage of a freezing microtome (American Optical Corp., Buffalo, NY). A series of 

200 µm coronal sections were collected containing the nucleus accumbens (NAc) core and shell, 

and caudate putamen (CPu) striatal regions between ~0.24 to ~5.16 Bregma (Paxinos and 

Watson 2005) onto gelatin coated slides (FD NeuroTechnologies). Sections were allowed to dry 

at room temperature in the dark for at least 72 hours prior to staining slides as described in the 

FD Rapid GolgiStain Kit staining procedure using Permount™ (Fisher Scientific) for cover 

slipping. 

Image and Spine Analysis 

Medium spiny neurons, identified by their medium-sized, round soma and spiny 

dendrites (Meredith et al. 1992), were imaged between ~0.96 and ~2.04 Bregma (Paxinos and 

Watson 2005) in the NAc core, NAc shell, and CPu (Fig 1.1). Hemispheric origin was noted to 

enhance equitable sampling but was not addressed as an experimental variable in this study. 

Using a Nikon Eclipse 55i microscope (Nikon, Japan) with 100X oil immersion objective and 
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Nikon Digital Sight DS-Fi1 camera (Nikon, Japan), series of images of Golgi impregnated 

dendrites acquired for neurons whose dendrites could be traced back to the originating soma. 

Following a published protocol (Risher et al. 2014), images were coded so that analysis was 

conducted blind, imported into ImageJ (ver. 1.53a, Java 8; https://imagej.nih.gov/ij/), converted 

to RGB color, and saved as separate image sequences for further analysis in RECONSTRUCT 

(https://synapseweb.clm.utexas.edu/software-0; Fiala 2005; Risher et al. 2014). In the 

RECONSTRUCT software, optical section thickness was set to 0.5 microns and pixel size was 

adjusted to reflect microns per pixel calculated from microscope images. Dendrite and dendritic 

spine measurements were performed by an observer blinded to treatment groups as previously 

described (Risher et al. 2014). Fully impregnated dendritic segments ~10 um in length within 

frame of the originating soma, with clearly defined spines, and free from obstruction by 

neighboring structures were analyzed. Selected dendritic segments were within frame of the 

originating soma to ensure proper attribution of neuron type, location, and distance from soma 

measurement. One dendritic segment was analyzed per neuron, serving as the experimental unit. 

Dendritic segment length was measured and all spines originating from the selected dendritic 

segment were measured for spine head width and spine length from dendritic trunk to spine head 

end in RECONSTRUCT. Both spine length and dendritic segment length measurements were 

performed using the ‘Draw Z trace’ tool to trace in-focus images throughout the image series for 

a somewhat 3-dimensional analysis, while spine head width was measured with the ‘Draw line’ 

tool for a straight, 2-dimensional measurement. Distance from soma was measured for all 

analyzed dendritic segments via the ‘Draw Z trace’ tool to trace the in-focus images of the 

dendrite from the dendrite-soma junction to the proximal end of the analyzed dendritic segment. 
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Intra- and intercurator controls revealed <6.5% difference between analyses of the same 

dendritic segment. 

Datasets for each analyzed dendritic segment were constructed in Excel (Microsoft, ver. 

2016 (16.0.5239.1001)). Spine attributes were calculated as following a previously published 

protocol (Risher et al., 2014). Spine density was calculated by dividing the total number of 

spines on a dendritic segment by the length of the dendritic segment (spines/um). Spine size was 

assessed by calculating the average length, width, and length:width ratio (length/width) for all 

individual spines on a dendritic segment. To classify spine type, spines were hierarchically 

categorized using the following parameters: branched (all spines designated as “branch” during 

RECONSTRUCT analysis), filopodia (length > 2 um), mushroom (width > 0.6 um), long thin 

(length > 1 um), thin (length:width ratio > 1 um), stubby (length:width ratio ≤ 1 um) (Risher et 

al. 2014).  Spine type percent of total was calculated by dividing the number of a particular spine 

type (example: total number of filopodia spines) by the total number of spines for a dendritic 

segment. 

Statistics 

Data were analyzed with unpaired two-tailed t tests using Welch’s correction, one-way 

ANOVA with Fisher’s LSD multiple comparison test, or a two-way ANOVA with Fisher’s LSD 

multiple comparison test as appropriate (GraphPad Prism ver 9.0). P values 0.05 were considered 

a priori as significant. Data values are represented as mean ± SE. 
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Results 

Dendritic spine density was increased in NAc core compared to NAc shell and CPu 

 

Figure 1.1. Location of analyzed medium spiny neuron (MSN) dendritic segments in adult rat nucleus accumbens 

(NAc) core, NAc shell, and caudate-putamen (CPu). A) Males. B) Females in diestrus. C) Females in proestrus AM. 

D) Females in proestrus PM. E) Females in estrus. Triangles represent analyzed dendritic segment location within 

slice. Acronyms: AC, anterior commissure; LV, lateral ventricle; NAc, nucleus accumbens; CPu, caudate-putamen. 

 

We first tested the hypothesis that dendritic spine density differed between striatal 

regions independent of sex or the estrous cycle. It has previously been shown that medium spiny 

neuron dendritic spine density is greater in the NAc core than the NAc shell region (Bello-

Medina et al. 2016; Forlano and Woolley 2009; Meredith et al. 1992). As a control experiment to 

validate our approach for analyzing spine attributes, we first analyzed spine density and spine 
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size independent of sex and the estrous cycle in the NAc core (Fig 1.2A), NAc shell (Fig 1.2B), 

and CPu (Fig 1.2C). Average spine length:width ratio, indicating average spine size, did not 

differ by striatal region (Fig 1.2D) (F(2,252)=0.2289, P=0.7956). Overall, spine density differed 

by striatal region. Spine density, or spines/µm, in the NAc core was significantly elevated 

compared to both the NAc shell and CPu (Fig 1.2E) (F(2,252)=6.249, P=0.0022; NAc core: 

2.008 ± 0.04942, n=86; NAc shell: 1.809 ± 0.05481, n=88; CPu: 1.775 ± 0.04496, n=81). Spine 

density in the CPu and NAc shell did not differ from one another. These results show that there 

are differences in spine density between striatal regions, replicating previous findings and 

validating our approach. 

 

Figure 1.2. Dendritic spine density differed by striatal region independent of sex or estrous cycle phase. A) 

Representative images of Golgi impregnated dendritic segments from MSNs in NAc core, B) NAc shell, C) and CPu. 

Scale bar 10 µm. D) Average spine size did not differ by striatal region. E) Dendritic spine density is elevated in NAc 

core compared to NAc shell and CPu. Acronyms: LWR, length:width ratio; **p<0.01. 
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No differences in spine attributes by sex, independent of estrous cycle 

We next disaggregated the data by sex to test the hypothesis that dendritic spine attributes 

differed by sex, in this case independent of estrous cycle phase. No differences in spine size by 

sex were detected in the NAc core (Fig 1.3A), NAc shell (Fig 1.3B), CPu (Fig 1.3C)(NAc: 

t(15.87)=1.036, P=0.3156, female n=73, male n=13; NAc shell: t(22.10)=1.760, P=0.0922, 

female n=73, male n=15; CPu: t(17.31)=1.042, P=0.3117, female n=65, male n=16). Likewise, 

no differences in spine density by sex were detected in the NAc core (Fig 1.3D), NAc shell (Fig 

1.3E), or CPu (Fig 1.3F) (NAc core: t(16.76)=0.4612, P= 0.6506; NAc shell: t(18.94)=0.3445, 

P=0.7343; CPu: t(22.79)=1.398, P=0.1755). Overall, no differences were detected between male 

and female groups when estrous cycle was not considered. 

Figure 1.3. No differences in spine size or spine density by sex independent of estrous cycle phase. A) NAc core spine 

size. B) NAc shell spine size. C) CPu spine size. D) NAc core spine density. E) NAc shell spine density. F) CPu spine 

density. Acronyms: LWR, length:width ratio. 
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Overall spine size differed across estrous cycle phases in female NAc core and NAc shell, spine 

length differed in NAc shell and CPu 

 

Figure 1.4. Overall dendritic spine size differed by estrous cycle phase in the NAc core and NAc shell, but not CPu. 

A) In NAc core, average spine size was decreased in proestrus PM compared to proestrus AM. B) In NAc shell, 

average spine size was increased in estrus compared to proestrus PM and diestrus. C) CPu spine size. D) NAc core 

spine density. E) NAc shell spine density. F) CPu spine density. Acronyms: LWR, length:width ratio; *, p<0.05; **, 

p<0.01. 
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0.1571, n=23; estrus: 3.208 ± 0.1768, n=11). Within NAc shell, overall spine size for both 

proestrus PM and diestrus were decreased when compared to estrus (Fig 1.4B) (F(3,69)=2.927, 

P=0.0398; diestrus: 2.926 ± 0.1486, n=24; proestrus AM: 3.075 ± 0.2506, n=13; proestrus PM: 

2.758 ± 0.1558, n=19; estrus: 3.472 ± 0.1832, n=17). There were no differences in overall spine 

size between estrous cycle phases within the CPu (Fig 1.4C) (F(3,61)=1.850, P=0.1476; diestrus: 

2.976 ± 0.1451, n=20; proestrus AM: 3.315 ± 0.2595, n=11; proestrus PM: 2.872 ± 0.1755, 

n=19; estrus: 3.349 ± 0.1398, n=15). No differences were detected across estrous cycle phases 

for spine density in the NAc core (Fig 1.4D), NAc shell (Fig 1.4E), and CPu (Fig 1.4F) (NAc 

core: F(3,69)=0.7434, P=0.5298; NAc shell: F(3,69)=0.2255, P=0.8784; CPu: F(3,61)=0.8993, 

P=0.4469), indicating that spine density is not sensitive to the estrous cycle within these striatal 

regions. Overall, these data indicate that overall spine size is sensitive to the estrous cycle in the 

NAc core and NAc shell. 

Given that changes were detected in spine size but not spine density, we further 

disaggregated the spine size dataset by length and width. Average spine length within the NAc 

core trended towards a decrease in proestrus PM when compared to proestrus AM and estrus 

phases (Fig 1.5A) (F(3,69)=2.240, P=0.0913; diestrus: 1.300 ± 0.04776, n=24; proestrus AM: 

1.424 ± 0.08085, n=15; proestrus PM: 1.221 ± 0.06692, n=23; estrus: 1.447 ± 0.09606, n=11). 

Within the NAc shell, average spine length was elevated in estrus compared to all other phases 

(Fig 1.5B) (F(3,69)=4.099, P=0.0098; diestrus: 1.220 ± 0.05634, n=24; proestrus AM: 1.254 ± 

0.08016, n=13; proestrus PM: 1.154 ± 0.06211, n=19; estrus: 1.470 ± 0.07551, n=17). Within the 

CPu, both proestrus PM and diestrus average spine length was decreased compared to estrus (Fig 

1.5C) (F(3,61)=3.138, P=0.0317; diestrus: 1.222 ± 0.05051, n=20; proestrus AM: 1.376 ± 

0.1061, n=11; proestrus PM: 1.246 ± 0.05632, n=19; estrus: 1.460 ± 0.05864, n=15). 
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Interestingly, no differences in average spine width across estrous cycle phases were found 

within the NAc core (Fig 1.5D), NAc shell (Fig 1.5E), or CPu (Fig 1.5F) (NAc core: 

F(3,69)=0.9723, P=0.4109; NAc shell: F(3,69)=0.1628, P=0.9210; CPu: F(3,61)=0.2449, 

P=0.8647). Overall, these data indicate that spine length, not width, is sensitive to the estrous 

cycle within the NAc and CPu. 

 

Figure 1.5. Average spine length differs by estrous cycle phase in the NAc shell and CPu, but not NAc core. A) In 

NAc core, spine length trends lower in proestrus PM compared to both proestrus AM and estrus. B) In NAc shell, 

spine length is elevated in estrus compared to all other phases. C) In CPu, spine length in elevated in estrus compared 

to diestrus and proestrus PM. D) NAc core spine width. E) NAc shell spine width. F) CPu spine width. Acronyms: 

LWR, length:width ratio; o, 0.05<p<0.1; *, p<0.05; **, p<0.01. 
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Dendritic spine types varied for males and females in each estrous cycle phase for NAc core, 

NAc shell, and CPu 

The detected differences in spine size, especially length, indicate that spine type may also 

differ within a region within each phase. We categorized spines into the following types: 

filopodia, long thin, thin, stubby, mushroom, and branched (Risher et al. 2014). Filopodia and 

long thin spine types represent the longest length spines of the six classifications. Stubby and 

thin spine types represent the shortest length spines of the six classifications. Mushroom spine 

types represent the widest spine type. We assessed the distribution of these spine types within a 

region for males and females in each estrous cycle phase. As expected, dendritic spine type 

distribution differed within each group in the NAc core (Table 1.1), NAc shell (Table 1.2), and 

CPu (Table 1.3). Complete analysis is included in the respective tables. Here we highlight 

relevant comparisons as indicated from the results of the global spine size assessments presented 

above.   

In the NAc core, global spine size assessment detected that overall spine size was smaller 

in proestrus PM compared to proestrus AM (Fig 1.4A). In proestrus PM, the percentage of spines 

classified as filopodia differed from long thin, thin, and branched (Table 1.1). The percentage of 

spines characterized as stubby differed from long thin and thin.  In contrast, in proestrus AM, the 

percentage of spines classified as filopodia differed from long thin and stubby, while the 

percentage of spines classified as stubby differed from filopodia, long thin, thin and mushroom.  

These changing spine distributions are consistent with a shift towards shorter spine types in 

proestrus PM compared to AM.    

In the NAc shell, overall spine length was greater in estrus compared to proestrus PM, 

proestrus AM, and diestrus (Fig 1.5B). In estrus, the percentage of spines classified as filopodia 
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differed from long thin, stubby, and branched (Table 1.2). The percentage of spines classified as 

stubby differed from filopodia, long thin, thin, and mushroom. In proestrus PM, the percentage 

of spines classified as filopodia differed from long thin and thin. The percentage of spines 

classified as stubby differed from long thin, thin, and mushroom. In proestrus AM, the 

percentage of spines classified as filopodia differed from long thin and thin. The percentage of 

spines classified as stubby differed from long thin and thin. In diestrus, the percentage of spines 

classified as filopodia differed from long thin and thin. The percentage of spines classified as 

stubby differed from long thin, thin, and mushroom. The distribution of spine types in estrus is 

consistent with a greater spine length compared to the distributions in proestrus PM and diestrus.  

In CPu, overall spine length was greater in estrus compared to proestrus PM, and diestrus 

(Fig 1.5C). In estrus, the percentage of spines classified as filopodia differed from long thin, 

stubby, and mushroom (Table 1.3). The percentage of spines classified as stubby differed from 

filopodia, long thin, thin, mushroom, and branched. In proestrus PM, the percentage of spines 

classified as filopodia differed from long thin and thin. The percentage of spines classified as 

stubby differed from long thin, thin, and mushroom. In diestrus, the percentage of spines 

classified as filopodia differed from long thin, thin, mushroom. The percentage of spines 

classified as stubby differed from long thin, thin, and mushroom.  Similar to the NAc shell, in the 

CPu the distribution of spine types in estrus is consistent with increased spine length compared 

to the distributions in proestrus PM and diestrus. 

  



   

18 

 

Table 1.1. NAc core dendritic spine types for males and females across estrous cycle phases 

 Filopodia Long 

Thin 

Thin Stubby Mushroom Branched Statistics 

(F, P) 

Diestrus 12.11 ± 

1.909 (24)a 

33.64 ± 

2.739 

(24)b 

26.08 ± 

2.976 

(24)b 

6.647 ± 

1.031 (24)c 

13.63 ± 

1.895 (24)a 

7.897 ± 

1.729 (24)a,c 

4.369e-012, 

<0.0001 

Proestrus 

AM 

19.24 ± 

3.415 (15)a,b 

29.53 ± 

2.547 

(15)c 

24.98 ± 

3.487 

(15)b,c 

3.944 ± 

1.217 (15)d 

13.01 ± 

1.820 (15)a 

9.291 ± 

2.639 (15)a,d 

4.151e-012, 

<0.0001 

Proestrus 

PM 

13.99 ± 

2.380 (23)a 

27.14 ± 

3.297 (23) 

b 

29.17 ± 

3.146 (23) 

b 

9.473 ± 

2.222 

(23)a,c 

16.23 ± 

2.186 (23)a 

3.996 ± 

1.316 (23) c 

4.764e-012, 

<0.0001 

Estrus 16.88 ± 

3.153 (11)a 

31.52 ± 

3.759 

(11)b 

25.65 ± 

3.640 

(11)a,b 

3.830 ± 

1.032 (11)c 

14.04 ± 

2.983 (11)a,d 

8.082 ± 

2.154 (11)c,d 

5.837e-012, 

<0.0001 

Males 13.69 ± 

1.546 (13)a 

32.27 ± 

3.346 

(13)b 

25.89 ± 

2.772 

(13)b 

3.606 ± 

1.824 (13)c 

14.47 ± 

2.175 (13)a 

10.08 ± 

2.388 (13)a,c 

1.361e-011, 

<0.0001 

Notes: Values are spine type percent of total, mean ± SEM. Numbers in parentheses indicate number of dendritic 

segments analyzed. Different superscript letters indicate statistically significant differences between dendritic spine 

types. Spine types with the same superscript letter do not significantly differ. 

 

 

Table 1.2. NAc shell dendritic spine types for males and females across estrous cycle phases 

 Filopodia Long 

Thin 

Thin Stubby Mushroom Branched Statistics 

(F, P) 

Diestrus 9.863 ± 

1.525 (24)a,b 

27.73 ± 

3.361 

(24)c 

34.44 ± 

2.932 

(24)c 

5.409 ± 

1.388 (24)a 

14.21 ± 

2.220 (24)b 

8.339 ± 

2.140 (24)a,b 

3.290e-012, 

<0.0001 

Proestrus 

AM 

13.77 ± 

2.353 (13)a 

23.77 ± 

3.340 

(13)b 

29.73 ± 

3.156 

(13)b 

10.59 ± 

2.449 (13)a 

11.93 ± 

3.102 (13)a 

10.20 ± 

2.242 (13)a 

7.819e-012, 

0.0002 

Proestrus 

PM 

9.147 ± 

2.040 (19)a,b 

30.42 ± 

2.769 

(19)c 

33.45 ± 

2.626 

(19)c 

7.407 ± 

2.007 (19)a 

14.30 ± 

2.120 (19)b 

5.275 ± 

1.821 (19)a 

5.539e-012, 

<0.0001 

Estrus 19.31 ± 

2.910 (17)a,b 

28.24 ± 

2.585 

(17)c 

26.10 ± 

3.606 

(17)a,c 

4.744 ± 

1.066 (17)d 

13.51 ± 

2.357 (17)b,e 

8.103 ± 

1.963 (17)d,e 

3.167e-012, 

<0.0001 

Males 16.40 ± 

2.911 (15)a,b 

28.52 ± 

2.681 

(15)c 

27.77 ± 

4.601 

(15)b,c 

4.582 ± 

1.540 (15)d 

9.534 ± 

2.295 (15)a,d 

13.19 ± 

1.896 (15)a 

4.734e-012, 

0.0002 

Notes: Values are spine type percent of total, mean ± SEM. Numbers in parentheses indicate number of dendritic 

segments analyzed. Different superscript letters indicate statistically significant differences between dendritic spine 

types. Spine types with the same superscript letter do not significantly differ. 
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Table 1.3. CPu dendritic spine types for males and females across estrous cycle phases 

 Filopodia Long 

Thin 

Thin Stubby Mushroom Branched Statistics 

(F, P) 

Diestrus 7.323 ± 

1.727 (20)a 

33.73 ± 

2.745 

(20)b 

26.57 ± 

2.327 

(20)b 

7.455 ± 

1.954 (20)a 

14.55 ± 

1.394 (20)c 

10.37 ± 

1.900 (20)a,c 

6.934e-012, 

<0.0001 

Proestrus 

AM 

14.74 ± 

3.582 

(11)a,b,c 

29.40 ± 

3.207 

(11)d 

29.03 ± 

4.590 

(11)b,d 

4.989 ± 

2.489 (11)a 

14.86 ± 

1.853 (11)c 

6.972 ± 

3.020 (11)a 

1.970e-012, 

0.0003 

Proestrus 

PM 

10.15 ± 

2.185 (19)a,b 

34.64 ± 

3.292 

(19)c 

26.34 ± 

2.790 

(19)c 

8.711 ± 

1.898 (19)a 

14.87 ± 

2.278 (19)b 

5.290 ± 

1.819 (19)a 

6.287e-012, 

<0.0001 

Estrus 20.21 ± 

2.935 (15)a,b 

31.13 ± 

2.487 

(15)c 

24.03 ± 

2.515 

(15)a,c 

3.668 ± 

1.021 (15)e 

10.18 ± 

2.056 (15)d 

10.79 ± 

2.817 (15)b,d 

8.939e-012, 

<0.0001 

Males 17.51 ± 

4.269 (16)a,b 

32.51 ± 

3.891 

(16)c 

26.90 ± 

3.576 

(16)b,c 

7.247 ± 

1.460 (16)a 

10.34 ± 

3.208 (16)a 

5.494 ± 

2.262 (16)a 

4.225e-012, 

<0.0001 

Notes: Values are spine type percent of total, mean ± SEM. Numbers in parentheses indicate number of dendritic 

segments analyzed. Different superscript letters indicate statistically significant differences between dendritic spine 

types. Spine types with the same superscript letter do not significantly differ. 

 

Discussion 

These findings are the first to demonstrate MSN dendritic spine plasticity in response to 

the estrous cycle. Interestingly, the sensitivity of MSN dendritic spines to estrous cycle phase 

notably differs across striatal regions and in specific dendritic spine size attributes. In the NAc 

core, overall spine size was decreased in proestrus PM compared to proestrus AM. In the NAc 

shell, overall spine size was elevated in estrus compared to proestrus PM and diestrus. Spine 

length differed across estrous cycle phases in female NAc shell and CPu. In the NAc shell, spine 

length was elevated in estrus compared to diestrus, proestrus AM, and proestrus PM. In the CPu, 

spine length was elevated in estrus compared to diestrus and proestrus PM. These findings 

indicate that rapid changes in spine attributes can occur within hours between proestrus AM and 

PM in specific regions of the adult rat striatum. Independent of sex or estrous cycle phase, 

dendritic spine density was greater in the NAc core compared to both the NAc shell and CPu, 

recapitulating previous findings and validating our approach (Bello-Medina et al. 2016; Forlano 

and Woolley 2009; Meredith et al. 1992; Staffend et al. 2011; Wissman et al. 2011).  
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Our work directly extends previous findings regarding the intersection of spine attributes 

with natural variables such as sex, estrous cycle phases, and estradiol in the striatal regions 

(Almey et al. 2012, 2015, 2022; Forlano and Woolley 2009; Gross et al. 2016; Peterson et al. 

2015a, 2016; Staffend et al. 2011; Wissman et al. 2011, 2012). While no study before this one 

has directly tested the hypothesis that MSN dendritic spine attributes are sensitive to the estrous 

cycle, previous experiments from other laboratories have demonstrated that MSN spines are 

sensitive to estradiol.  Treatment of ovariectomized female hamsters and rats with estradiol 

resulted in decreased spine density in the NAc core (Peterson et al. 2015a; Staffend et al. 2011), 

concomitant with a shift from more mature to less mature spine types (Staffend et al. 2011), 

similar to what was later reported in the perirhinal cortex (Gervais et al. 2015). Spine size was 

not assessed in these studies. This decrease in NAc core MSN dendritic spine density in response 

to estradiol was found to be mediated by a mGluR5/endocannabinoid pathway (Gross et al. 

2016; Peterson et al. 2015a, 2016). With MSN dendritic spine plasticity previously linked to 

estradiol exposure, we hypothesized that spine attributes would differ across the estrous cycle. 

This initial hypothesis was further informed by previous experiments from Woolley and 

colleagues that detected sex differences in specific spine attributes and glutamatergic synapse 

markers between males and females rats from the proestrus phase (other phases were not 

examined) (Forlano and Woolley 2009; Wissman et al. 2011, 2012). 

Surprisingly, we found that spine size rather than spine density differed across estrous 

cycle phases. Specifically, during the high estradiol phases of the estrous cycle, spine size in the 

NAc core and shell was generally smaller compared to other phases, with changes in spine length 

detected in the NAc shell and CPu. Our use of the Golgi process may have detected smaller spine 

sizes that might have not been apparent with a different technique such as the DiOlistic labeling 
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employed in earlier studies (Forlano and Woolley 2009; Peterson et al. 2015a, 2016; Staffend et 

al. 2011, 2014). The current study also by necessity employed a different mounting media than 

earlier studies where DiOlistic labeling was used and mounting media has been shown to 

influence dendritic spine density measurements (Peterson et al. 2015b). These differences in 

technique may have resulted in a detected shift in spine size rather than density in our data. We 

favor this possibility as the most likely explanation as to why the current study detected a 

decrease in spine size rather than spine density. Another potential explanation is that 

progesterone or some other relevant hormone also regulates spine attributes, resulting in 

differential results in dendritic spine properties than when estradiol is considered alone 

(discussed below). Alternatively, Woolley and colleagues previously reported that rostro-caudal 

location within the NAc core played a role in detection of sex differences with differences in 

spine density between males and females in proestrus only evident in the caudal NAc core 

(Bregma 1.44 to 1.0), and spine head width, a measure of spine size, only differing in the rostral 

NAc core (Bregma 2.0 to 1.56) (Wissman et al. 2012). Since we sampled MSNs mostly from 

Bregma 1.92 to 1.44, it is possible that only spine size varies within these rostral portions of the 

NAc core, NAc shell, and CPu. Further experiments utilizing additional samples from the caudal 

portions of the NAc core, as well as the NAc shell and CPu should be performed to gain a more 

comprehensive view of spine plasticity by estrous cycle phase. To gain maximum insight, we 

recommend that these future studies evaluate both spine density and global spine size, as well as 

specific spine size attributes. Based on the findings made here, our recommendation is that the 

spine size attributes include both length and width. 

For example, the current study found that global spine size differed by cycle phase in the 

NAc core and shell. In this study, global spine size is composed of the averages of the spine 
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length to width ratios within groups, following a previously established protocol (Risher et al. 

2014). These detected spine size differences represent an overall shift from larger spines in the 

proestrus AM phase to smaller spines in proestrus PM for the NAc core with a shift from larger 

spines in estrus to smaller spines in proestrus PM and diestrus phases for the NAc shell. When 

broken down further, we found the main driver in this shift to be spine length, which differed by 

cycle phase in the NAc shell and CPu, and trended towards a difference in NAc core, wherein 

spine length was generally longest in estrus and shortest in proestrus PM. This data indicates that 

spine length rapidly decreases from proestrus AM to proestrus PM and then recovers by the next 

morning of estrus, a rapid shift similar to previously detected changes across the estrous cycle in 

the hippocampus (Brandt et al. 2020; Woolley et al. 1990), but never before in a striatal region. 

This change in dendritic spine length in a matter of hours across estrous cycle phase is 

remarkable. 

This rapid change in spine size is further upheld by the shifts in spine types assessed 

within each phase of the estrous cycle for NAc core, NAc shell, and CPu. A qualitative analysis 

of the relationships between spine type proportions provides insight into these shifts between 

estrous cycle phases (Fig. 1.6). This analysis was pursued within each region, including males 

and females in each estrous cycle phase.  In the NAc core (Fig. 1.6A), the relationship between 

spine type proportions changes from phase to phase. For example, proestrus AM features a 

relatively larger proportion of long spine types, such as filopodia and long thin. Proestrus PM 

features a relatively larger proportion of short spine types, such as thin and stubby. Another 

interesting pattern also emerges from this analysis of the NAc core: males and females in 

diestrus exhibit an identical pattern of relationships between spine type proportions, as indicated 

by the same line array in Figure 1.6A. Consistent with this conclusion, males and females in 
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diestrus also share similar percentages of each spine type (Table 1.1). This observation 

corresponds to data indicating that the electrophysiological properties of NAc core MSNs from 

females in the diestrus phase are similar to males, unlike MSNs recorded during other estrous 

cycle phases (Proaño et al. 2018, 2020).  Regarding the NAc shell, this analysis provides several 

expedient observations (Fig. 1.6B). In the NAc shell, estrus features a relatively larger proportion 

of long spine types compared to short spine types, which is different from all other phases. For 

example, both diestrus and proestrus PM show a larger proportion of short spine types compared 

to long spine types. The relationships between spine type proportions within each of these phases 

closely resemble one another. Proestrus AM features a more equal distribution of spine type 

proportions than any other phase, as indicated by smaller weighted and/or missing relationship 

lines. These differences in spine type proportion relationships between proestrus AM and other 

phases could explain why no global spine size differences were detected (Fig. 1.5B). In the CPu 

(Fig. 1.6C), estrus features a relatively larger proportion of long spine types compared to short 

spine types. In contrast, diestrus and proestrus PM both feature a relatively larger proportion of 

short spine types, namely stubby, compared to long spine types, namely filopodia. Similar to the 

NAc shell, proestrus AM in the CPu features few significant differences between spine type 

proportions. Overall, this analysis of spine type distribution is consistent with findings that 

global spine size and length are sensitive to estrous cycle phase in select striatal regions. 
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Figure 1.6. Visual representation of spine type distributions for males and females of each estrous cycle phase. A) 

NAc core. B) NAc shell. C) CPu. Circle diameter indicates spine type proportion, with larger diameters indicating 

increased proportion. Circle color corresponds with spine type.  Connecting lines between spine type circles indicate 

the presence of a statistically significant difference between proportions. Lack of a line indicates no significant 

difference exists in proportion between the respective spine types. Line weight represents p value, with increasing 

weight indicating decreasing p value. Quantitative metrics are provided in Tables 1-3. Acronyms: F, filopodia; LT, 

long thin; T, thin; S, stubby; M, mushroom; B, branched. 
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Differences in spine size across the estrous cycle are also significant in that they align 

with previously synaptic electrophysiological experiments, especially in the NAc core. Whole-

cell patch clamp recordings of NAc core MSNs discovered that the frequency and amplitude of 

mEPSCs change across the estrous cycle. mEPSCs are a direct functional assessment of AMPA 

receptor-mediated synapses and can correlate with dendritic spine attributes. Specifically, 

mEPSC frequency is intermediate during diestrus, elevated during proestrus AM, plummets 

during proestrus PM, and is again elevated during estrus (Proaño et al. 2018, 2020). This 

decrease in mEPSC frequency during proestrus PM directly aligns with the detected decrease in 

spine size in proestrus PM, suggesting a neuroanatomical mechanism. Importantly, mEPSC 

frequency is typically interpreted as an indicator of the number of available active glutamatergic 

synapse. It is a logical model that as dendritic spine size decreases, that the number of active 

glutamatergic synapse will likewise decrease, resulting in a lower mEPSC frequency. Consistent 

with this model, mEPSC frequency inversely correlates with circulating concentrations of 

estradiol and progesterone, both of which would be higher during the proestrus PM phase 

compared to most other phases. This correlation has been tested causally by the application of 

estradiol directly onto MSN neurons while recording mEPSCs. Female but not male MSNs lower 

mEPSC frequency in response to estradiol exposure (Proaño et al. 2018). Interestingly, mEPSC 

amplitude in NAc core MSNs also changes across the estrous cycle. mEPSC amplitude is 

typically indicative of changes at the post-synaptic side of the synapse, for instance in the 

number of AMPA receptors per synapse. mEPSC amplitude is intermediate during the diestrus 

and proestrus AM phases, elevated during proestrus PM, and returns to intermediate levels 

during estrus (Proaño et al. 2018, 2020). NAc core MSN mEPSC amplitude correlates with 

circulating concentrations of estradiol and progesterone, and in both females and males is weakly 
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sensitive to acute exogenous estradiol exposure. Thus, it is possible that the changes in dendritic 

spine size observed in NAc core proestrus PM in the present study reduce the number of 

available synapses, leading to a decrease in mEPSC frequency, and either potentiate the 

remaining synapse or simply eliminate weaker synapse, leading to the increase in mEPSC 

amplitude. The current study also detects differences in spine length across the estrous cycle in 

CPu. Longer spines were measured in estrus phase compared to diestrus and proestrus PM. 

Unlike the NAc core, the functional relevance of the changes in CPu spine length are not as 

clear. One previous study assessed mEPSC properties across the estrous cycle in CPu MSN, 

however no changes in mEPSC properties were detected (Willett et al. 2020). Concerning the 

NAc shell, to our knowledge there have been no studies of synaptic physiology across the estrous 

cycle, or comparing by sex in adult animals to complement a previous study of prepubertal 

animals (Willett et al. 2016). We recommend that studies of synaptic physiology in the NAc 

shell across estrous cycle phases should be performed given that differences in spine size were 

detected in this brain region. 

At this point, the mechanism driving rapid changes in spine size remains unknown.  

Several pertinent possibilities exist. One possibility derives from the model first articulated by 

Mermelstein, Meisel, and colleagues that was briefly mentioned above. In their experiments, 

changes in spine attributes in gonadectomized female rat NAc core induced by exogenous 

estradiol administration were mediated via an estrogen receptor (ER) associated 

mGluR5/endocannabinoid pathway (Gross et al. 2016; Peterson et al. 2015, 2016; Staffend et al. 

2011). The natural changes in spine attributes across the estrous cycle may also be mediated via 

this same pathway. Membrane-associated ERs are anatomically situated on both the pre- and 

post-synaptic side of MSN glutamatergic synapses in the NAc core and CPu (Krentzel et al. 
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2019) and dopaminergic synapses in the NAc core, shell, and CPu (Almey et al. 2012, 2016, 

2022);  localizations consistent with this model. To help drive future experiments, we have 

developed the following speculative model for how estrous cycle associated dendritic spine 

plasticity may be derived. We hypothesize that the estradiol peak in proestrus AM creates a 

delayed effect on dendritic spines that is measurable in the proestrus PM hours. This is seen in 

the data as a rapid reduction in spine size, particularly length, between proestrus AM and 

proestrus PM. This estradiol influence on dendritic spine size may be mediated through 

membrane associated ERs on the presynaptic side of the synapse, as ERs are more abundant on 

the presynaptic side of NAc core and shell synapses (Almey et al. 2022), perhaps inducing a 

delayed effect on spine size through altering neurotransmitter release (Micevych and Christensen 

2012). There may also be actions via ER activation on the postsynaptic side of the synapse, as 

MSNs express ERs in that location and in the soma (Almey et al. 2012, 2016, 2022; Krentzel et 

al. 2019). 

Importantly, the ER/mGluR5/endocannabinoid model articulated in previous publications 

does not encompass other key estrous-cycle associated hormone fluctuations such as 

progesterone. Changes in mEPSC properties are correlated with circulating plasma progesterone 

concentrations, and the estrous cycle phase with some of the greatest changes in spine attributes 

is proestrus PM, when progesterone concentrations are high (Proaño et al. 2020; Woolley and 

McEwen 1993). Woolley and McEwen (1993) and Murphy and Segal (2000) observed a rapid 

attenuation of estradiol effects on dendritic spine density in vivo in ovariectomized rat CA1 

hippocampus and in cultured hippocampal neurons, respectively. To our knowledge, 

progesterone’s effects on spine attributes has not been investigated in the striatum. With this in 

mind, our speculative model hypothesizes that the peak in progesterone occurring in proestrus 
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PM hours then rapidly attenuates estradiol’s delayed effects on spine properties, seen in the data 

as an increase in spine size in estrus compared to proestrus PM. To test the hypotheses that 

progesterone rapidly attenuates estradiol’s delayed effects on MSN dendritic spine attributes, it 

would be beneficial to conduct an experiment much like Woolley and McEwen’s by introducing 

estradiol and/or progesterone to gonadectomized male and female rats to determine the timed 

effects on MSN dendritic spines. A future study should examine the naturally cycling animal’s 

temporal cytoskeletal markers from striatal tissue at various stages of the estrous cycle, 

particularly before, during, and after estradiol and progesterone surges occurring in proestrus 

AM and PM and continuing effects in the estrus phase. 

Changes in MSN dendritic spine dynamics could also interact with dopaminergic action. 

We found that spine length rather than spine head width drove differences across the estrous 

cycle. Dendritic spine necks are often sites for dopaminergic input onto MSNs and dopamine 

levels are implicated in regulating spine attributes, at least in the CPu (Alberquilla et al. 2020; 

Arbuthnott et al. 2000). Decades of literature implicate estradiol in altering dopamine signaling 

dynamics in the striatum (Yoest et al. 2018). While there is data regarding changing dopamine 

levels and the estrous cycle (Dluzen and Ramirez 1985; Xiao and Becker 1994), to our 

knowledge it is unknown how dopamine levels change between proestrus AM and proestrus PM 

in any striatal region. We also note that MSNs differentially express dopamine receptors, 

creating MSN subtypes that could exhibit differential responsivity to estrous cycle phase 

(Calipari et al. 2016; Staffend et al. 2014). We recommend that this be addressed, since it holds 

ramifications for both natural processes and relevant disorders. Thus, another line of future 

investigation could be centered around dopamine’s involvement in estrous cycle-associated spine 

dynamics. 
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In conclusion, these data are the first to show that MSN dendritic spine attributes are 

sensitive to estrous cycle phase. Moreover, spine size attributes rapidly shift between cycle 

phases, mirroring equally rapid shifts in electrophysiology, discussed above, and relevant 

behaviors. It has long been documented that behaviors modulated by the striatal regions, 

especially motivated locomotor and reproductive-related behaviors influenced by NAc, can 

rapidly change between estrous cycle phases or exposure to estradiol (Krentzel et al. 2020; 

Meitzen et al. 2018; Yoest et al. 2018). Thus, it is tempting to speculate that the structural 

dynamics observed here hold strong implications for function and behavioral output, although 

the ultimate function is not yet known. Nevertheless, the findings presented here provide 

important information, linking previous work establishing the sexually differentiated nature of 

MSN dendritic spines and glutamatergic input, studies that employed gonadectomized animals 

and exogenous estradiol replacement paradigms to assess MSN dendritic spine attributes and 

elucidate underlying molecular mechanisms, and electrophysiological studies upon MSNs in 

naturally cycling females across estrous cycle phases. Collectively, this body of work highlights 

the relevance of the estrous cycle for dendritic spines, a fundamental component of striatal 

neuroanatomy implicated in a wide range of behaviors and disorders. 
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Appendix A 

Relevant Protocols 

Adjusting Images in ImageJ 

1. Open ImageJ 

2. File > Import > Image Sequence 

3. Find the first picture of the image series you want to analyze 

a. Try to open a series with a single neuron, which can multiple dendritic segments 

for analysis, to keep it simple (example of file name: Neuron N) 

4. Sequence Options will open 

a. “Number of images” is however many images are in the series to analyze 

b. “Starting image” and “Increment” are 1 

c. “Scale images” is 100% 

d. “File name contains” is blank 

e. Click boxes for “Convert to RGB” and “Sort names numerically” 

f. OK 

5. Edit > Options > Conversions 

a. Click boxes for “Scale when converting” and “Weighted RGB conversions” 

b. OK 

6. Image > Type > 8-bit 

a. To achieve grayscale 

7. Scroll through your stack to find an image with a dendritic segment appropriate for 

analysis (where finer spine heads are in focus) 

a. Try to find an uninterrupted, unobscured, ~10um segment that is the desired 

distance from the soma 

8. Image > Adjust > Brightness/Contrast 

a. Adjust the Brightness as needed 

i. Aim for a brightness that makes the background more white 

Note: the following values were used in pilot and trial run images 

PILOT - Click to the right 20-25 times – 20 

TRIAL – Click to the right 15-20 times – 15 

see study notes for adjustment values from main study 

b. Adjust the Contrast 

i. Note: zoom in on the segment(s) of interest so you can adjust contrast so 

the finer spine heads that are in focus are most clearly separate from the 

background, but not too far where the other spine heads that are less 

defined begin to loose volume in the image 
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Note: the following values were used in pilot and trial run images 

PILOT - Click to the right 15-20 times – 20 

TRIAL – Click to the right 10-20 times – 15 

see study notes for adjustment values from main study 

c. When satisfied, click “Apply” 

9. Scroll back through your stack to observe a planes of focus for the dendritic segment for 

analysis to see if everything is as clear and distinguishable as possible 

a. Adjust brightness and contrast (Step 8) again as needed 

10. Record all adjustments made to the image stack in lab notebook.  

a. If needed, take a picture of the Brightness/Contrast settings for your records. 

Name the picture for the stack you are working on. This can serve as a reference 

when adjusting other stacks, to maintain consistency 

11. File > Save As > Image Sequence 

a. “Format” is TIFF 

b. “Name” is formatted “name of neuron_adjusted sequence” (example: Neuron 

N_Adjusted Sequence) or something of the like to help clearly identify which 

neuron and that this is not the raw image sequence 

c. “Start at” and “Digits (1-8)” can be left as is 

d. “Use slice labels as file names” is unchecked 

e. OK 

12. Create a folder within the folder containing the neuron’s raw image sequence 

a. Name the folder “name of neuron_adjusted sequence” (example: Neuron 

N_Adjusted Sequence) or something of the like 

13. Within the folder created in Step 12a, save your image sequence under the file name 

created in Step 11b 

14. Exit ImageJ 
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a. It will ask if you want to save changes to “name of raw image sequence file” 

(example: Neuron N) that you opened in Step 3. DO NOT save the changes or it 

could alter the raw image stack 

15. Find your folder created in Step 12a, open it and open one of the images saved in Step 

11b 

a. Note: sometimes the name of the files will revert to “original file name, number 

of image in sequence” (example: Neuron N0001) 

i. Rename the files as you wish and/or record in lab notebook name of files 

belonging to the raw image sequence and name of files belonging to the 

adjusted sequence 

16. If the image looks correct, you can proceed to analysis in RECONSTRUCT 

Calculating Microns per Pixel to use in RECONSTRUCT Analyses 

1. Open the image of the calibration slide at 100x oil in ImageJ.  

a. File > Import > Image Sequence 

b. Select the file (in this case it is named “100x oil, 10 microns between lines” 

c. Open 

2. Select the following in Sequence Options 

a. Number of image, starting image, increment are all 1 

b. Scale image is 100% 

c. Leave File name contains blank 

d. Select the boxes for Convert to RGB an Sort names numerically 

e. OK 

3. Select the *Straight* line option on the toolbar  

4. Click and hold to draw a line from the midpoint of one black line to the midpoint of the 

next black line. Be careful to make the line parallel to the horizontal black line in the 

image. 

5. Set the scale 

a. Analyze > Set Scale 

b. Leave Distance in pixels alone. 

c. Change Known distance to 10 

d. Leave pixel aspect ratio alone 

e. Change Unit of length to “um” 

f. Select the box for Global 

g. OK 

6. Notice that right above the image are numbers next to the file name. (ex: “100x oil, 10 

microns between lines.tiff”; # x # um (1280 x 960); RBG; 4.7MB) 

a. Record the um values (first value is x axis, second value is y axis) 

b. Records the pixel values (1280 is x axis, 960 is y axis) 

7. Calculate microns per pixel 

a. Take the x axis um value and divide it by the x axis pixel value 

i. You can also do this with the y axis um value divided by the y axis pixel 

value 

b. This is your um per pixel scale. You will use this when importing images into 

RECONSTRUCT for analysis 
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Dendritic Segment Measurement in RECONSTRUCT 

See publication from  

Risher WC, Ustunkaya T, Singh Alvarado J, Eroglu C (2014) Rapid Golgi Analysis Method for 

Efficient and Unbiased Classification of Dendritic Spines. PLoS ONE 9(9): e107591. 

doi:10.1371/journal.pone.0107591 

Analyzing Dendritic Segment Data in Excel 

1. Open the excel sheet.  

a. The “analysis” tab is where the data will be analyzed to calculate spine type, 

density, and other details. 

b. The d1 spine width tab has my data for the spine widths 

c. The d1 spine length tab has my data for spine length 

2. Since you want to do calculations with your own data, you need to delete the following: 

a. On the analysis tab, delete info from columns “segment length,” “trace name,” 

“width,” and length” 

b. Delete the whole tab called “d1 spine width” 

c. Delete the whole tab called “d1 spine length” 

Now you are ready to import your saved data from the RECONSTRUCT analysis 

3. Create a new tab and title it “d1 spine width” 

a. In that tab, click on a cell 

b. Then go to the “Data” section of the tool bar 

c. Select “from Access” (top left) 

d. Find and open the folder where you saved the “d1_spines” or whatever the title of 

your file is from the spine width (d1_spine+ and d1_slen) list you saved from 

RECONSTRUCT 

NOTE: You may need to change the file type from “access databases” to ”all files” in order to 

locate it 

e. A box called “text import wizard” will pop up 

i. (page 1 of 3) Leave the “delimited” box checked and hit “Next>” 

ii. (page 2 of 3) Select “Comma” from the options for delimiters and hit 

“Next>” 

iii. (page 3 of 3) Click “Finish” 

iv. Then click “OK” in the import data box 

4. Repeat all of step 3 for another tab in the excel file titled “d1 spine length” to import the 

“d1_ztraces” (or other name) that you saved the d1spineZlen info/list from 

RECONSTRUCT 

Now you are ready to put this data into the analysis tab 

5. Go to the “d1 spine width” tab and copy the names of the spine heads (ie: “d1_spine1”) 

a. Paste these in the “Trace Name” column on the analysis tab (paste values only to 

avoid weird formatting) 

6. Go to the “d1 spine width” tab and copy the numerical values in the Length column for 

all spines (do not copy the value for “d1_slen”) 

a. Paste these in the “Width” column on the analysis tab (paste values only to avoid 

weird formatting) 

7. Go to the “d1 spine length” tab and copy the numerical value in the Length column for 

“d1_Zlen” 

a. Paste this value in “segment length” column. (paste value only) 



   

40 

 

b. Make sure this fills all rows (in the column) with spine data!!! (Ie: if there is a 

trace name/width in the 17th row, make sure the d1_Zlen value fills every cell 

down to the 17th row in the segment length column 

8. Go to the “d1 spine length” tab and copy the numerical values in the length column for 

all spines (careful not to copy the d1_Zlen this time) 

a. Paste these in the “Length” column on the analysis tab (paste values only) 

NOTE: Now make sure all copy/pasted values line up with the correct spine!!!!!!!!!!!! If the 

alignment got off anywhere, it will mess the analyses up. Redo if necessary 

9. On the analysis tab, make sure the formulas for” LWR” and “Type” columns fill all rows 

in which there is spine data 

10. Also make sure the “Field,” “Segment,” and “DEN ID” columns all have 1 in every row 

in which there is spine data 

11. Don’t forget to save the file. 
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Appendix B 

Academic Genealogy 
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Appendix C 

Selected Images of Golgi Impregnated Medium Spiny Neurons 

 


